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Preface
      

      
      
      
      We wrote this book as a guide that you can count on and refer to as you develop your own apps for iOS using the iOS 7 SDK.
         We tried to cover topics in a simple and immersive way—a way that allows you to learn by getting your hands dirty. It’s always
         easier to learn something new by doing, and that’s exactly what you’ll find in this book, and that’s what defines books in the In Action series. The book will allow you to learn at your own pace by building real-world applications for each of the topics covered
         in each of the chapters.
      

      
      We assume that you’re already motivated to write your own iOS apps and want to get started right away, so we won’t spend much
         time convincing you. If you’ve never created an app before, rest assured that you will have created your very first one after
         the first chapter. This book will act as your trusted guide whether you want to dive into iOS development, or only want to
         learn how to use the new features available in iOS.
      

      
      You’ll learn what makes up an iOS application and thus gain a deep understanding of its different components. These many components
         have to come together to make an app truly great. As you go along, the topics you’ll learn will give you the knowledge you
         need to build more impressive apps on your own. And then we will have succeeded in what we set out to do!
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About this Book
      

      
      
      
      If you’re interested in developing apps for iOS, then this book is for you.

      
      There are a few prerequisites to be able to use the book effectively. First, you need to be interested in developing apps
         for iOS. You should have a Mac or at least a computer that’s running OS X. Also, although object-oriented methodologies and
         Objective-C are covered in the appendix, it’s helpful to have an understanding of both.
      

      
      With the prerequisites out of the way, this book is beneficial for developers new to iOS or those who are experienced iOS
         developers who want to learn more about creating apps for iOS. The book is structured so that you can skip a chapter if you
         already have a good understanding of the topic. Most of the chapters and the apps we create in them are atomic to allow you
         to read just the ones you need if you’re already experienced.
      

      
      
      
Roadmap
      

      
      This book has 14 chapters and is divided into 3 parts.

      
      Chapter 1 gets your development environment up and running, teaches you about iOS fundamentals, and lets you build your first application.
      

      
      Chapter 2 gives you an in-depth look at views, controls, and the view coordinate system. You also take a look at view controllers and
         how to support multiple orientations. This is done while enhancing the application that you built in the first chapter.
      

      
      Chapter 3 teaches you how to use storyboarding to organize the view controllers in your application. We’ll use different scenes and
         show you how to transition and pass data between them by creating a task management app.
      

      
      Chapter 4 introduces you to table views, table view controllers, and prototype cells so that you can organize and present data as lists.
         You’ll use a table view of albums in the Photos application.
      

      
      Chapter 5 looks at collection views and custom collection view cells. You’ll also use custom collection view flow layouts to organize
         photos in an application you create to display your photos.
      

      
      Chapter 6 goes into retrieving remote data using iOS and custom third-party libraries. You’ll learn how to use web views to display
         web pages within an application.
      

      
      Chapter 7 takes an in-depth look at the Assets Library framework, which allows you to access all of the media on your device. You’ll
         learn how to retrieve assets, display them, and capture photos and videos with the image picker. By the end of the chapter
         you’ll have an application that can display the metadata for a photo.
      

      
      Chapter 8 introduces you to the Accounts and Social frameworks by creating an application for access to Twitter and Facebook feeds.
      

      
      Chapter 9 explores advanced view customization by going beyond Interface Builder. You’ll learn how to create custom views and animations
         by creating your own animated clock application.
      

      
      Chapter 10 gives you an introduction to Core Location and MapKit. Using these two frameworks, you’ll learn how to retrieve your current
         location and heading and how to geocode location data. By the end of the chapter you’ll build an app that shows your current
         speed and location.
      

      
      Chapter 11 looks at persistence and object management by utilizing Core Data. You’ll find out the differences between Core Data and
         traditional databases and use this knowledge to build a Core Data–backed task management application.
      

      
      Chapter 12 teaches you how to use AirPlay for streaming media and to display content on external screens. You’ll learn how to create
         your own music application that streams and displays song information through an Apple TV.
      

      
      Chapter 13 explores how to notify users of your app by sending them push notifications. This chapter goes in depth on how to configure
         your app to send and receive remote push notifications and how to schedule local notifications.
      

      
      Chapter 14 explores adding the parallax effect and realistic animations such as gravity, bouncing, elasticity, and friction to views
         in your applications. You’ll see how easy it is to add these effects using iOS 7’s APIs for motion and UIKit Dynamics.
      

      
      
      
      
Code conventions and downloads
      

      
      There are many code examples throughout this book. These examples always appear in a fixed-width code font like this. If we want you to pay special attention to a part of an example, it appears in a bolded code font. Any class name or method within the normal text of the book appears in code font as well.
      

      
      Some of the lines of code are long and break due to the limitations of the printed page. Because of this, line-continuation
         markers ([image: ]) may be included in code listings when necessary. Code annotations accompany some of the code listings, highlighting important
         concepts.
      

      
      Not all code examples in this book are complete. Often we show only a method or two from a class to focus on a particular
         topic. Complete source code for the applications found throughout the book can be downloaded from the publisher’s website
         at www.manning.com/iOS7inAction.
      

      
      An Intel-based Macintosh running OS X 10.7 or higher is required to develop iOS 7 applications. You also need to download
         the iOS SDK, but this is freely downloadable as soon as you sign up with Apple.
      

      
      
      
      
Author Online
      

      
      Purchase of iOS 7 in Action includes free access to a private web forum run by Manning Publications where you can make comments about the book, ask technical
         questions, and receive help from the authors and from other users. To access the forum and subscribe to it, point your web
         browser to www.manning.com/iOS7inAction. This page provides information on how to get on the forum once you’re registered, what kind of help is available, and the
         rules of conduct on the forum.
      

      
      Manning’s commitment to our readers is to provide a venue where a meaningful dialog between individual readers and between
         readers and the authors can take place. It’s not a commitment to any specific amount of participation on the part of the authors,
         whose contribution to the AO remains voluntary (and unpaid). We suggest you try asking the authors some challenging questions
         lest their interest stray!
      

      
      The Author Online forum and the archives of previous discussions will be accessible from the publisher’s website as long as
         the book is in print.
      

      
      
      

About the Cover Illustration
      

      
      
      
      The figure on the cover of iOS 7 in Action is captioned “Morning Habit of a Russian Lady in 1764.” The illustration is taken from Thomas Jefferys’s A Collection of the Dresses of Different Nations, Ancient and Modern (4 volumes), London, published between 1757 and 1772. The title page states that these are hand-colored copperplate engravings,
         heightened with gum arabic. Thomas Jefferys (1719–1771) was called “Geographer to King George III.” He was an English cartographer
         who was the leading map supplier of his day. He engraved and printed maps for government and other official bodies and produced
         a wide range of commercial maps and atlases, especially of North America. His work as a map maker sparked an interest in local
         dress customs of the lands he surveyed and mapped; they are brilliantly displayed in this four-volume collection.
      

      
      Fascination with faraway lands and travel for pleasure were relatively new phenomena in the eighteenth century and collections
         such as this one were popular, introducing both the tourist as well as the armchair traveler to the inhabitants of other countries.
         The diversity of the drawings in Jeffreys’s volumes speaks vividly of the uniqueness and individuality of the world’s nations
         centuries ago. Dress codes have changed, and the diversity by region and country, so rich at one time, has faded away. It
         is now often hard to tell the inhabitant of one continent from another. Perhaps, trying to view it optimistically, we have
         traded a cultural and visual diversity for a more varied personal life—or a more varied and interesting intellectual and technical
         life.
      

      
      At a time when it is hard to tell one computer book from another, Manning celebrates the inventiveness and initiative of the
         computer business with book covers based on the rich diversity of national costumes two centuries ago, brought back to life
         by Jeffreys’s pictures.
      

      
      
      
      


Part 1. Basics and necessities
      

      
      
      When the water’s cold, it’s better to jump in without hesitation. You’ll be doing just that as you learn the important principles
         necessary for iOS development. These are many of the core principles and tools you’ll be utilizing when you start creating
         more advanced applications.
      

      
      In chapter 1 you’ll be introduced to iOS, the development environment, and will even create your own Hello World application called Hello
         Time.
      

      
      Chapter 2 takes an in-depth look at the user interface layer of an iOS app. You’ll learn about views, controls, and view controllers.
         Chapter 3 expands on views and view controllers by going into storyboarding and scenes. By using storyboards you’ll be able to organize
         and transition among multiple view controllers in your application.
      

      
      In chapter 4 you’ll tackle the common problem of organizing data into a list. You’ll do this by using table views. We’ll then segue into
         chapter 5, where you’ll learn how to organize data using collection views.
      

      
      
      
      
      


Chapter 1. Introduction to iOS development
      

      
      This chapter covers

      
      

      
         
         	Introduction to iOS development
            
         

         
         	Designing applications for the mobile paradigm
            
         

         
         	Building and running your first iOS application
            
         

         
         	Objective-C and MVC primer
            
         

         
         	Overview of Apple’s development tools
            
         

         
      

      
      Developing iOS apps is something that many people wish they knew how to do. How many times have you heard people say, “If
         only there was an app for...”? By the end of this book you’ll be able to create those apps and possibly create one that could
         be downloaded by millions of people around the world. Even by the end of this chapter, you’ll be able to call yourself an
         iOS developer after we create our first iOS application together.
      

      
      Many people who want to develop for iOS get scared away by the perceived complexity of the platform. You’ll soon learn that
         once you focus on just the essentials, you won’t feel overwhelmed as most people do with other iOS books. It’s also crucial
         to be able to apply what you’ve learned by using that knowledge to create something tangible. The best way to learn is by
         doing, and that’s just what you’re going to do.
      

      
      Instead of just reading about these topics, you’ll be building useable applications so that you can see first-hand how they
         work and how you can use them in real-world applications. Throughout this book we’ll be covering core iOS topics and many
         of the great new things in iOS like UIKit Dynamics, AirPlay, Social framework, table and collection views, auto layout, animation,
         Core Data, and much more. By creating focused applications based on each topic, you’ll have a better understanding of what
         you’ve just learned. Within this chapter is a quick overview of iOS and then you’ll quickly jump into making your first iOS
         app, as shown in figure 1.1.
      

      
      
      
      Figure 1.1. Hello Time, a fully functioning clock application that tells the time, which we’ll build together by the end of this chapter
      

      
      
      
      [image: ]

      
      
      
      You’ll be creating an app called Hello Time, which is a fully functioning clock application that tells the current time. While
         creating Hello Time you’ll become familiar with the ins and outs of iOS development. You’ll then review exactly what you did
         while creating the app and learn more iOS development fundamentals.
      

      
      
      
1.1. Developing for iOS
      

      
      iOS 7 is the seventh major release of Apple’s iOS Software Development Kit. The SDK provides many frameworks and tools used
         to create applications for iPhone, iPad, and iPod touch devices that you can release in Apple’s App Store. As you go through
         this book, you’ll learn why developing for iOS is different than developing for the web or desktop, and you’ll go through
         the steps of setting up your development environment to create your own iOS apps.
      

      
      
      1.1.1. Different kind of design interaction
      

      
      The iPhone’s release brought a new type of device into the mainstream that relied on fingertips for input with capacitive
         screens. It also allowed us to use natural multitouch gestures with our fingers that mimicked those once only found in the
         movies. It’s this type of interactive design that makes developing for iOS quite different from developing for desktop and
         web applications. It’s also this amazing level of interaction and ease of use that allows toddlers and young children to interact
         with iOS apps.
      

      
      On iOS devices, when browsing the web through Safari, you flick the screen upward with the tips of your fingers to scroll down. To go to the next photo in the Photos app, you flick to the left. When you use the Maps app, you pinch the screen to zoom outward. To zoom in, you could pinch outward or double-tap with one finger. If you want to “click” a button, you tap it. Other gestures allow you to interact with apps to reveal options for a particular item. For example, the Mail app displays a context menu after swiping to the left on an email.
      

      
      App developers also have to take into account that everything needs to be displayed on a small 3.5”–4” device. You’re limited
         with screen real estate, which requires you to present information to your users in a reasonable manner. You also need to
         take into account expected usage patterns and interactions. Almost everybody who uses apps on their phone uses them for short
         periods of time. You not only have to limit what’s presented on a screen of this size but also limit the number of interactions
         required to accomplish a particular task. It’s difficult to make something simple, but this type of design interaction can
         make your apps more successful than those of your competitors.
      

      
      
      
      1.1.2. Getting ready to develop for iOS
      

      
      To develop for iOS you’ll need to have an Intel-based Mac running at least Mac OS X v10.8.4 (Mountain Lion). You’ll have to
         install Xcode 5, Apple’s integrated development environment (IDE), to create iOS applications. Xcode is available for free,
         and you can find it by searching for it in the Apple App Store or by going to http://developer.apple.com/xcode/. Once you’ve downloaded and installed it, you’ll be ready to start creating your first application.
      

      
      
      
      
      
1.2. Creating your first iOS application
      

      
      Ready to create your first iOS app? Instead of a basic Hello World application, you’ll create something with more functionality
         that can serve as the base of a real-world application. You could even submit it to the App Store if you decided to spend
         a little more time on it. You’re going to create an application called Hello Time, which will be a fully functional clock
         that will show you the current time.
      

      
      
      1.2.1. Creating the Hello Time application in Xcode
      

      
      Before continuing, make sure that Xcode has finished installing. Once it’s installed, open it by choosing Applications > Xcode.
         Then you can start creating a new project by going to the application menu and choosing File > New > Project. You’ll then
         be presented with many different application templates to choose from. Choose Single View Application and click Next, as shown
         in figure 1.2.
      

      
      
      
      Figure 1.2. Choosing Single View Application as the template for your Hello Time project
      

      
      [image: ]

      
      
      You’ll then be prompted to fill out the name of the project, organization, company identifier, and class prefix. The name
         of the project should be Hello Time. The organization name and company identifier as well as the class prefix are for you
         to decide. We’ll be using the prefix IA throughout the rest of the book to stand for “In Action.” This will help you identify
         your own files that are related to your project, which is important when you import other libraries into your projects. This
         is shown in figure 1.3.
      

      
      
      
      Figure 1.3. Options you need to specify when creating your new project
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      After clicking Next, you’ll be prompted to save the project on your computer. Consider creating a new folder on your computer
         that holds all of your iOS applications. This will keep your projects organized and make them easy to find in the future.
         Once you’ve created your project, you’ll be taken to the main project window within Xcode. You can see all of the different
         files that were automatically created for you on the left side of the window in figure 1.4.
      

      
      
      

      
      
      Figure 1.4. Our newly created Hello Time project within Xcode
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      Let’s get started piecing together the application, beginning with the interface.
      

      
      
      
      1.2.2. Creating the application interface
      

      
      On the left side of the window, click Main.storyboard to bring up Xcode’s interface editor. Your interface will be fairly
         simple and straightforward because you’re showing only one piece of information on the screen, which is the current time.
         You’re going to add a label to the view in the scene that was created for you in your app’s storyboard. This label will be
         used to display the current time.
      

      
      On the bottom right of the window you’ll see the Object Library. To make sure you’re able to see this, you can also manually
         show it by selecting View > Utilities > Show Object Library within the application menu (Control-Option-Command-3). Once you
         have the Object Library showing, find the Label object. You can do this by scrolling down through the list or by searching for it in the search field underneath, as shown
         in figure 1.5.
      

      
      
      
      Figure 1.5. Find the Label object in the bottom-right corner of the interface editor.
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      Note that you may be in the icon view instead of the list view. You can change this by clicking the icon to the left of the
         search field. Drag this label into the blank view with the white background. Try to arrange it so that it is aligned in the center of the view, as shown in figure 1.6.
      

      
      
      

      
      
      Figure 1.6. Drag the label into the view and align it so that it is centered horizontally and vertically.
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      You’re going to change the appearance of this text to make it look much better than the default label styling. With the label
         still selected within your view, go to the application menu and choose View > Utilities > Show Attributes Inspector (Option-Command-4).
         This will load a new window on the right that you can use to edit the object that’s currently selected. You can see this in
         figure 1.7.
      

      
      
      
      Figure 1.7. The attributes inspector after dragging the label into our view
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      Change the font to System Bold with a size of 30.0. Also change the alignment so that the text is centered. After doing this
         your label might not appear correctly because the width of the label is too small to hold the default text, as shown in figure 1.8.
      

      
      
      

      
      
      Figure 1.8. Changing the font and alignment of your label within the attributes inspector
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      Change the width of the label by clicking and dragging the two center anchors on the left and right sides of the label. Drag
         them so that the label’s width is the exact same width as the view it’s contained within. The height also needs some adjustment.
         Drag the middle anchor on the top of the label to make it taller. It should look similar to what’s shown in figure 1.9.
      

      
      
      
      Figure 1.9. Adjust the width and height of the label to ensure that the text fits after changing the font size.
      

      
      
      
      [image: ]

      
      
      
      You’re almost finished with your view. The most important aspect is the ability to have your code communicate with different
         parts of your view.
      

      
      
      
      
      1.2.3. Connecting your user interface to your code
      

      
      You’re going to create a connection between your interface and your code. This connection will enable your code to communicate
         with the label you’ve just created. We’ll spend more time on this in the next chapter, but it’s important to note that this
         is something that you’ll be using with every application we create together.
      

      
      Open the assistant editor in Xcode by going to the top right of the window and choosing the middle tab within Editors. You
         can also open it by choosing View > Assistant Editors > Show Assistant Editor (Option-Command-4). The assistant editor automatically
         opens IAViewController.m for you because you were working on its view. Change this to show IAViewController.h, as shown in
         figure 1.10.
      

      
      
      
      Figure 1.10. Opening the assistant editor while working on the view will bring up the associated view controller.
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      You’ll now create the connection between your label and your code, which is referred to as an outlet. You’ll be learning more about outlets and their importance in the next chapter. Create an outlet for your label by holding
         down Control on your keyboard, clicking your label, and dragging a connection to IAViewController in the assistant editor, as shown in figure 1.11.
      

      
      
      
      Figure 1.11. Clicking and dragging a connection from our label to our view controller to create an outlet
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      Once you let go, you’ll see a popup that will ask you what you want to name your label. Call it timeLabel and click Connect. This will create a property for you within IAViewController.h that you can use within your code to make
         changes to your label—in this case, to display the current time. The code that will be inserted into your code should look like the following:
      

      
      @property (weak, nonatomic) IBOutlet UILabel *timeLabel;

      
      Now that your view is connected to your view controller, you can start working on implementing the clock functionality.

      
      
      
      1.2.4. Implementing the clock functionality
      

      
      You’ll now implement the functionality needed for a basic working clock. Find IAViewController.m to open the implementation
         of your view controller. Add the following method within Xcode’s code editor:
      

      
      - (void)checkTime:(id)sender
{
    NSDateFormatter *formatter = [[NSDateFormatter alloc] init];
    [formatter setDateFormat:@"h:mm:ss a"];
    [self.timeLabel setText:[formatter stringFromDate:[NSDate date]]];

    [self performSelector:@selector(checkTime:) withObject:self
    [image: ] afterDelay:1.0];
}

      
      This code can be seen added to IAViewController in figure 1.12.
      

      
      
      

      
      
      Figure 1.12. The checkTime: function added to IAViewController's implementation
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      This method will get the current date and format it so that you’re displaying only the time. It will then change the text
         of timeLabel by calling setText:. The last line tells your controller to call this method again every second. This will cause the time to be updated on your
         label every second, just like a regular clock.
      

      
      The last thing you need to do is have this method called when your view loads. Luckily there’s a method called viewDidLoad that was already prepopulated for you when you created your project. This method is triggered after your view has finished
         loading and is the perfect place for you to trigger the checkTime: method. Add the following to the bottom of the viewDidLoad method:
      

      
      [self checkTime:self];

      
      Adding that line to call the checkTime: method will kick-start your clock, which will have it updating the time every second. After doing this, you won’t have to
         do anything else. Why’s that? Well, because you’ve already finished creating your first iOS application! Your interface has
         been set up and connected to your code. Your code will update the label in your view with the current time every second. You’ve
         created a fully functional clock application that tells the time.
      

      
      
      
      1.2.5. Building and running your application
      

      
      You can finally build and run your application to see just what we’ve built together. This is extremely simple to do. If you
         look at the top left of the Xcode window, you should see a button with a “play” icon on it and with the label Run underneath.
         Once you click it, Xcode will automatically build your application and then launch it within the iOS Simulator. If there is
         a problem building your application, the compiler will inform you of any errors it encountered.
      

      
      Click the Run button to build and run your application, as shown in figure 1.13.
      

      
      
      
      Figure 1.13. Click the Run button to build and launch your application.
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      Once your application launches, you should see it running in the iOS Simulator. It will show the current time and update itself
         every second, as shown in figure 1.14.
      

      
      
      
      Figure 1.14. Our Hello Time application running within the iOS Simulator
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      It’s amazing that you’ve already created your first iOS application. You’ve created the interface, connected an outlet between
         your label and your code, and added functionality to set the current time. How about we dig deeper into iOS development by
         exploring its fundamentals?
      

      
      
      
      
      
1.3. iOS development fundamentals
      

      
      When creating your application you didn’t need to write much Objective-C. Knowing Objective-C is just one piece of iOS development.
         It’s the same as knowing all the words of a particular language. If you know the meaning of all of the words in the English
         dictionary but don’t know how to form sentences, it’s like knowing Objective-C but not knowing how to use Apple’s APIs. Cocoa
         Touch is Apple’s API for creating iOS apps.
      

      
      We’ll give you a quick introduction to object-oriented programming, Objective-C syntax, MVC, and frameworks. There are whole
         books written on these topics, so we’ll just touch on a few important things that you should be familiar with before moving
         forward. If you’re interested in learning about these items in more detail, please take a look at the appendix.
      

      
      
      
      1.3.1. Object-oriented programming
      

      
      In a nutshell, object-oriented programming (OOP) is a concept in programming in which objects and their structure are generally
         more important than the logic needed to manipulate the objects. Before OOP was introduced, programs were seen as recipes or
         procedures with a set of instructions that you could follow from start to finish. As soon as programs started to become more
         complex, a new method was needed to reduce this complexity. Object-oriented programming helps solve this complexity by allowing
         you to break down and flesh out your logic in a more natural way.
      

      
      When things are broken out into objects, they are easier to understand; we relate to them because they are similar to the
         world around us. Objects can be named anything to represent something that would hold data within your program. An object
         could be a person defined by different properties such as name, age, sex, gender, and so on. It could also be a home with
         properties like address, city, state, price, bedrooms, bathrooms, and the like. Your Hello Time application could be changed
         to have a clock object that has the time. Instead, your Hello Time app has a Label object in its view that has a text property. You modified this text property on this object to display the current time.
      

      
      Every object in Objective-C is a child, or subclass, of NSObject. Objects are defined as classes, and they can have children and parents. Much like in the real world, subclasses, or children,
         inherit the properties of their parents. For instance, you could have a class called Automobile with properties make and model. You could then create a subclass of Automobile called Truck that would represent a different type of automobile. You wouldn’t need to re-create or redefine the make and model properties because it would inherit them from its parent. You could, however, add properties that are specific to a truck
         like the bed size, whether or not it has four-wheel drive, and so on.
      

      
      The concepts found in object-oriented programming are easily transferred from one language to the next. Even though we haven’t
         gone through many specifics and intricacies of OOP, you should have an understanding of what to expect and enough background
         to be able to move forward.
      

      
      
      
      1.3.2. Objective-C syntax and message passing
      

      
      The common response for people new to Objective-C is that the syntax makes the language look daunting and confusing. They
         are often thrown off by the use of brackets everywhere. Once you understand why and just how the syntax works, it will all make sense and become easy to read.
      

      
      Messages are passed to a particular object. Generally, whatever is declared on the left side within a set of brackets is the
         object, and whatever is on the right side is the message you’re passing to it.
      

      
      [object message];

      
      The message you’re passing to it has to be a predefined method or function that has been defined on that particular object.
         If one hasn’t been defined, you’ll get an error telling you that the object doesn’t know how to respond.
      

      
      You can even pass in an argument or a parameter with a message:

      
      [object message:parameter];

      
      Many people get confused when they see multiple parameters being passed in a method. The previous example has one parameter.
         Imagine if you had a method definition that looked like the following:
      

      
      -(void) message:(id)parameterOne secondParam:(id)parameterTwo;

      
      You would call this method by passing in the parameters as such:

      
      [object message:paramOne secondParam:paramTwo];

      
      As you can see, the whole name of the method, or the message you’re calling, is message:secondParam:. The parameters are declared after each colon defined in the method name.
      

      
      Let’s now take a look at creating a new instance of a real object in Objective-C. Here you’re creating a new instance of an
         NSString object.
      

      
      [[NSString alloc] init];

      
      This is the standard way of creating a new object instance. Don’t be confused by the multiple brackets. You can break this
         down to see how these messages are being passed. You’re first calling [NSString alloc] in the first set of brackets. Then you’re calling init. You could break this into two lines:
      

      
      NSString *string = [NSString alloc];
[string init];

      
      This is perfectly fine except that it’s much easier to do [[NSString alloc] init] instead of breaking it into two separate lines. The takeaway here is that whatever is returned within the inner set of brackets
         is then passed a message by the outer brackets.
      

      
      From the previous example you can also see that you’re returning a reference to a new NSString object and storing it as an instance variable called string. You did the same thing within the checkTime: method that you created in your Hello Time app when you needed to create something to format the time for you.
      

      
      NSDateFormatter *formatter = [[NSDateFormatter alloc] init];
[formatter setDateFormat:@"h:mm:ss a"];

      
      You created an instance of NSDateFormatter and stored a reference to it in the variable named formatter. You then passed it a message to set the date format property by passing in a string value as the parameter.
      

      
      
      
      1.3.3. The Model-View-Controller pattern
      

      
      The Model-View-Controller (MVC) pattern is a design pattern that assigns objects in an application to one of three different
         roles. These roles are a model, a view, and a controller, as shown in figure 1.15. You may already be familiar with this pattern, because many other frameworks often implement MVC.
      

      
      
      
      Figure 1.15. Communication between models, views, and controllers within MVC
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      Using MVC, models encapsulate data and logic specific to an application. You didn’t have any models in your Hello Time application;
         it wasn’t necessary because of its lack of complexity. A view object is something whose main purpose is to visually display
         information to the user. View objects learn through controllers about the model, which contains the data that they can display.
         You created your view by modifying the storyboard within the interface editor. Controllers act as the intermediary between
         view and model objects. You connected your view to your controller, and your controller made the changes to your label to
         display the current time every second.
      

      
      
      
      1.3.4. Frameworks introduction
      

      
      Frameworks are compiled libraries that you can use to add functionality to your applications. By default, when you create
         a new iOS project in Xcode, it automatically includes the frameworks UIKit, Foundation, and CoreGraphics. UIKit provides classes
         to create and manage user interfaces. Foundation provides the base layer of Objective-C classes. Core Graphics provides functionality
         based on the Quartz drawing engine. It aids with image manipulation, color management, gradients, shadings, and the like.
         These three frameworks give you the basic functionality to create iOS applications.
      

      
      If you wanted to access all of the photos and videos on your iOS device, you could use the Assets Library framework, which
         contains classes that allow you to do just that. If you were to build a web browser, you’d use the WebKit framework. You’ll
         be using various frameworks to add in functionality to the apps that you build in the book. You’ve now had a general overview
         and introduction to OOP, Objective-C syntax, message passing, MVC, and frameworks. Because you’ll be spending most of your
         time in Xcode, let’s go over it in more detail so that you become more comfortable with your development environment.
      

      
      
      
      
      
      
1.4. Overview of Apple’s development tools
      

      
      You’ll be spending almost all of your development time within Xcode and the iOS Simulator. If you’re not already familiar
         with these tools, this quick introduction should help you get started. Apple has a few other tools that you can use for development,
         but these are the two that you’ll be using 99% of the time. Let’s get started by getting familiar with Xcode and creating
         our first app together.
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